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1.1 ABOUT 

ArCADia-ELECTRICAL INSTALLATIONS is an intelligent tool extending the ArCADia-

INTELLICAD/AutoCAD software with the features necessary to create professional indoor electrical installations 

designs. The software is addressed to designers of networks, installations of electric and power networks, as well 

as to anyone associated with the electro-technical industry. The user who employs ArCADia-ELECTRICAL 

INSTALLATIONS is able to quickly create drawings of indoor electrical installations in architectural projections 

of buildings. He may also employ a library of objects used when designing, along with an option to edit the objects 

and add technical parameters to them. Apart from the option to efficiently create drawings of the installations, the 

software also carries out the calculations necessary for designing the installation correctly and creating a 

professional technical report. Merging specialized features used in the application for creating electrical 

installation drawings in the scope of installing sockets and lighting along with carrying out the calculations and 

running validity checks on the designed network provides the perfect tool for creating indoor electrical 

installations. 

1.2 FEATURES AND FUNCTIONALITIES OF THE PROGRAM 

Technical scope of the software and its basic features: 

 
 Creating drawings of indoor electrical installations in the scope of installing sockets and lighting. 

 Designing emergency and escape lighting. 

 Designing indoor power supply lines. 

 Preparing power balance calculations for the designed buildings. 

 Determining the values of the necessary technical parameters. 

 Verifying the validity of the designed electrical installation. 

 Selection of power protection measures. 

 Generating calculation reports. 

 Automatically generating a legend of the symbols used in the project. 

 Generating schedules of quantities for the materials used in the project. 

 Generating schematic diagrams of indoor power supply lines. 

 Option to change item views. 

 

All calculations and the verification carried out by ArCADia-ELECTRICAL INSTALLATIONS were 

developed based on the following standards, regulations as well as scientific and technical publications: 

 

[1] PN-87/E-90050. General-purpose power conductors to be placed permanently. General requirements and 

tests. 

 

[2] Electric installations in buildings. Installations in residential housing. Design basics. Determining the 

calculated power demand. SEP standard, N-SEP-E-002. 

 

[3] PN-91/E-05009/482 – Protection against electric shock. 

 

[4] PN-EN 60865-1:2002 (U) Calculation of short-circuit currents effects. Part 1: Definitions and calculation 

methods 
 

[5] PN-EN 60909-0:2002 (U) Short-circuit currents in three-phase AC networks. Part 0: Calculations of 

currents. 
 

[6] PN-EN 60269-1:2001 (U) LV safety thermal fuses. General requirements.  
 

[7] PN-E-05033:1994 Guidelines for electric installations. Selection and installation of electric equipment. 

Wiring. 

 

[8] PN-EN 60617-3:2003 Graphic symbols used in diagrams. Part 2: Symbol elements, differentiating 

symbols and other general purpose symbols. 
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[9] PN-IEC 60364-5-523 "Electric installations in buildings. Selection and installation of electric equipment. 

Continuous current-carrying capacity of conductors". 

 

[10] PN-IEC 60364-4-41 "Electric installations in buildings. Protection for safety. Protection against electric 

shock". 

 

[11] PN-EN 60617-11:2004 Graphic symbols used in diagrams. Part 11: Architectural and topographical plans 

and diagrams of electric installations. 

 

[12] Markiewicz H. "Instalacje Elektryczne, Wydanie szóste" Wydawnictwo Naukowo-Techniczne, Warsaw 

2005 

 

[13] Wiatr J. "PORADNIK PROJEKTANTA ELEKTRYKA – Podstawy zasilania budynków mieszkalnych, 

użyteczności publicznej i innych obiektów nieprzemysłowych w energię elektryczną" 

 

[14] PN-EN 60439-1:2002 (U) Rozdzielnice i sterownice niskonapięciowe – Zestawy badane w pełnym 

i niepełnym zakresie badań typu. 

 

[15] Musiał E.: Współczynnik jednoczesności a współczynnik zapotrzebowania. Biul. SEP INPE "Informacje 

o normach i przepisach elektrycznych", 2005, no. 68-69, p. 65-70. 
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2 INSTALLING AND RUNNING THE SOFTWARE 
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2.1 HARDWARE REQUIREMENTS 

 Procesor Intel Core 2 Duo lub AMD Athlon II (recommended min. Intel Core i5-6500) 

 3 GB RAM (recommended min. 12 GB and system 64-bit) 

 5 GB of free HDD space (recommended SSD) 

 For standard 3D view  graphics card compatible with DirectX 9.0c 1GB RAM,  

for advanced 3D view graphics card compatible with DirectX 11 and min. 3GB RAM 

 Windows 10 , Windows 8.1 , Windows 7 SP1 (recommended Windows 10 64-bit) 

2.2 INSTALLATION 

The program installation starts automatically when the CD is inserted into the drive. The installation should be 

started manually if the Autostart function is disabled. Open the CD content (Computer/CD drive), and run the 

Setup.exe file from the program folder. Once the installation is started, proceed according to instructions displayed 

on the screen. 

2.3 RUNNING THE SOFTWARE 

The software may be started by double-clicking on the CAD program icon located on the Desktop and then 

selecting one of the icons on the ArCADia-ELECTRICAL INSTALLATIONS toolbar. 

2.4 OPENING A PROJECT (CAD) 

Any of the following file types may be opened: 

 

 A standard DWG drawing file.  

 Any of the following sample drawings supplied with the ArCADia-INTELLICAD software may be used.  

 A DXF drawing exchange file.  

 A DWF network transmission file.  

 A DWT drawing template file.  

 

In order to quickly access the last edited drawing, choose File > <file name>. The software stores the names of the 

last four drawings. In order to quickly access a drawing from the Open drawing dialogue box, double-click its 

name. 

A drawing may be opened when browsing drawings on the computer using e.g. Windows Explorer. All you need 

to do to open the drawing in ArCADia-INTELLICAD is to double-click the file. Thumbnails displayed when 

browsing help identify the drawing you need. 

 

Opening an existing drawing 

1. Use one of the following methods: 

 Choose File > Open. 

 On the Standard toolbar select the Open ( ) tool. 

 Type open and then press Enter.  

2. Choose the type of the file you want to open from the file type.  

3. Choose the folder that contains the selected drawing.  

4. Do one of the following:  

 Choose the drawing that you want to open and click Open.  

 Double-click the drawing you want to open.  

If the drawing requires a password, provide the password; click OK to verify the password and then click Open 

again. 
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2.5 SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing, use one of the following methods: 

 On the Standard toolbar click Save. 

 Choose File > Save. 

 Type save and then press Enter. 

 Type qsave and then press Enter. 

 

When you save a particular drawing for the first time, the system will display a dialogue box Save drawing as, 

which allows you to select the folder and provide the name for the drawing. You can use any name when saving 

the drawing for the first time. In order to save the same drawing under a different name later, select File > Save as 

and then type in the new name. 

2.6 AUTOSAVE AND BACK-UP COPY (CAD) 

In order to avoid data loss in case of a power outage or a system error, it is necessary to save your drawing files 

often. The software may be configured to periodically save your drawings automatically. The Autosave setting 

determines the interval in minutes between automatic saves. The software resets this interval each time the user 

saves a drawing file. 

 

When the Autosave feature is activated, the software creates copies of the drawing. These files are automatically 

saved to the folder provide under Options > Paths/Files > Temporary file and given the extension indicated in the 

Drawing autosave file extension (SV$ by default). 

 

Configuring ArCADia-INTELLICAD to automatically save drawings 

1. Do one of the following: 

 Select Tools > Options. 

 Type config and then press Enter. 

2. Click the General tab. 

3. In the Autosave area select one of the check boxes in order to enable the Autosave feature and select the 

autosave frequency. 

4. Click OK. 
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3 WORKING WITH THE SOFTWARE 
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3.1 BASIC SOFTWARE INFORMATION 

ArCADia-ELECTRICAL INSTALLATIONS allows creating drawings of indoor electrical installations in the 

scope of installing sockets and lighting. The course of action for designing installations is as follows: 

 

1. You start designing an installation by locating and determining the parameters of a distribution board in 

the building. You need to determine its basic features and parameters. Technical calculations will not be 

carried out if the designed installation does not contain a distribution board. 

2. Due to the different methods of designing indoor electrical installations the software provides the user 

with two variants (variant 1 – drawing the cabling installation, variant 2 – determining addresses for 

consumers). Both variants will be described in detail when describing the "distribution board" item. 

3. The next step for designing an electrical installation in the building is to determine the basic parameters 

of the consumers installed, determining their technical parameters and placing them on the architectural 

projection of the building. After distributing all the consumers the user may move over to placing control 

elements that may be found in the "electric switches" item. 

4. Then the user moves over to drawing the installation or uses the second variant (inputs the name of the 

distribution board and the number of the circuit). An installation is drawn using "electric conductors", 

after having determined the parameters of the conductor (conducting material, conductor cross-section, 

number of wires in the conductor, method of laying and casing design). 

5. Electric conductors are connected to the distribution board (by clicking the mouse on the board item) and 

then you route the installation to the previously placed consumers. The procedure may be done in reverse 

order (from the consumers to the board). When the user is done routing the conductor and does not 

connect it to a consumer, a distribution box appears where you can continue to route the circuit further. 

After drawing the route the user may route circuit branch lines using the "distribution box" item. A 

distribution box will appear at each point where the user will try to connect a conductor to a conductor. 

This facilitates and greatly improves the speed of drawing an electrical installation. When you already 

have designed an installation in the building, you can coordinate and determine parameters (power 

factors, demand factors and simultaneity, as well as protective devices) for the circuits output from the 

distribution board. The "distribution board" is used for controlling the entire electrical installation.  

6. After having designed the installation you can generate legend of the symbols used in the project and a 

report containing the results of technical calculations for each circuit output from the switchroom along 

with the power supply conductor (internal power supply line). The report provides detailed information 

about the power supply conductors, protective devices and their triggers, as well as the most important 

electric parameters for each circuit. The user can also generate a list of materials necessary to execute the 

designed network, which can be used for preparing a bid for the investment project. 

3.2 SOFTWARE ELEMENT DESCRIPTION 

ArCADia-ELECTRICAL INSTALLATIONS adds its own tools to the ArCADia-INTELLICAD/AutoCAD 

menu, as described in the tables below: 

 

 
 

 

*BIM – options available to ArCADia BIM license holders, i.e. after purchasing one of the following 

programs: ArCADia, ArCADia AC, ArCADia LT or ArCADia PLUS. 
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Fig. 1.  ArCADia-ELECTRICAL INSTALLATIONS toolbar 

 

Features of the System ribbon *BIM 

 

Show/Hide 

Project 

Manager 

Displays or hides the level management window. √ 

 

Program option 

settings 
Enables the use of standard options for the entire project. √ 

 Features of the ArCADia-ELECTRICS ribbon  

Icon Function Description *BIM 

 

Insert 

distribution 

board 

Inserts a distribution board with a description. √ 

 
Insert electric 

socket 
Insert electric socket with a description. √ 

 
Insert lighting 

fixture 
Inserts a lighting fixture with a description. √ 

 
Insert electric 

connector 
Inserts an electric connector with a description. √ 

 Insert cable Insert an electric cable. √ 

 Insert gang box Inserts a g box with a description. √ 

 
Insert ceiling 

cable conduit  
Inserts a ceiling cable conduit with a description. √ 

 

Insert schematic 

diagram 
Generates a schematic diagram of the installation Χ 

 Insert item list Inserts a symbols legend with a description. √ 

 
Insert selected 

elements list 

Inserts symbols legend along with item labels of the items selected in the 

projection. √ 

 
Generate 

material list 
Generates quantitative lists of materials used in the project. √ 

 

Insert material 

list for selected 

elements 

Generates a quantitative material list for the elements selected in the 

projection. √ 

 

Electric 

installation 

report 

Generates a report presenting technical calculations and the validity of the 

designed network. Χ 

 Show options Displays the options window. √ 

 Show help Displays the help window. √ 

Table 1. Description of the ArCADia features necessary for working with  

the ArCADia-ELECTRICAL INSTALLATIONS software 
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Fig. 2 ArCADia-ELECTRICAL INSTALLATIONS PLUS toolbar 

Icon Option Description *BIM 

 Cable tray Inserts cable tray. Χ 

 Vertical cable tray Inserts vertical cable tray. Χ 

 Cable leader Inserts cable leader. Χ 

 
Vertical cable 

leader 
Inserts vertical cable leader. Χ 

 Cable channel Inserts cable channel. Χ 

 
Vertical cable 

conduit 
Inserts vertical cable conduit. Χ 

 
Eksport DIALux Exports rooms to the DIALux program. Χ 

 
Import DIALux Imports .stf files from the DIALux program. Χ 

 

 

Once an item is clicked, the following tool bar is shown on the model: 

a) Distribution board. 

                   

Fig. 2. Distribution board item editing bar 

 – Move to the Properties window, 

 – Font and bar painter, 

 – Type painter, 

 – Edit description, 

 – Set description on the link, 

 – Item renumbering, 

 – Move with connected pipes, 

 – Internal circuit manager, 

 – Remove marked elements, 

 – Project library, 

 – Global library. 
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b) Other items 

 

Fig. 3. Electric conduit item editing bar 

 

 – Add point, 

 – Remove point, 

 – Create real view. 

 – Move without connections, 

 – Move with connections. 

 

3.2.1 General software options 

The user will also have the possibility to switch on the options window from the ArCADia menu. An action bar 

will extend, where the user needs to select Options. The general options window of ArCADia software will be 

displayed and then ArCADia–ELECTRICAL INSTALLATIONS. 

 

 

Fig. 4. Software option window for the ArCADia-ELECTRICAL INSTALLATIONS 
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On the left side of the options window one of the buttons is options for inserting elements. After clicking the button 

the user may open the Options for inserting elements window: 

 

 

Fig. 5. Tracking options window 

On the left side the user may define how precisely (maximum distance from the element axis which will allow for 

detection) will the elements, axes and angles be detected while element axis  and angles  tracking is enabled 

and elements detection  is enabled. 

 

Angles tracked may be inserted on the right side of the window. In the table the user may add, using the  

button, another angle that he wants to be tracked when entering elements. If the user wants to delete one of the 

angles, he needs to select it by clicking it in the table and then delete one of the values using the  button on the 

right.  

 

After defining the modification precision and the number and values of the angles tracked, the user may confirm 

the changes using the OK button (changes will be saved in the software) or reject them using the Cancel button 

(all changes done at the time in the tracking options window will be cancelled). 

 

 

Network rated voltage Un 

Voltage factor c, used to calculate:  

maximum short-circuit current 

cmax
1) 

minimum short-circuit 

current cmin 

Low voltage between 100 

V and 1000 V  

1.05 2) 
0.95  

1.10 3) 

Table 2. Voltage factor c 

 

1) cmax ∙ Un cannot exceed the highest device voltage, Um 

2) for LV (within a range of + 6%, e.g. for 380 or 400 V) 

3) for LV (within a + 10% range). 

If the user would like to check what heat impacts will result from the short-circuit current, he should use a high 

voltage factor (c=1.1). 

 

If the user needs to verify the speed of automatic tripping by the protective device, he should use a low voltage 

factor (c=0.8). 
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3.3 CALCULATIONS 

 

Once the installation has been designed and appropriate parameters have been assigned to it, ArCADia-

ELECTRICAL INSTALLATIONS will carry out standard calculations:  

 

 initial single-phase short-circuit current calculations (minimum and maximum in case of an earth fault) 

in the particular circuits of the designed installation, 

 calculation of load currents (1-phase or 3-phase) for the particular circuits of the installation, 

 calculation of voltage drops in each circuit, 

 calculation of the expected short-circuit loop impedance, 

 calculation of peak power in the designed installation and the peak powers for each designed circuit, 

 determination of the protection trip current for short-circuits within a time-frame defined by the user, 

 determination of the protective device trip current for circuit overload, 

 determination of continuous current-carrying capacity. 

 

Once the technical calculations are carried out and the necessary parameters are established, ArCADia-

ELECTRICAL INSTALLATIONS reports all the electric values for the power supply line and each circuit 

output from the distribution board that are necessary for the correct selection of electric conductors (due to the 

long-term current carrying capacity and voltage drop), correct choice of protection (retention of electric shock 

protection) and coordination of conductors with protective measures. 

 

Based on the report the designer may verify any potential errors in the designed electrical installation. The report 

is generated in RTF format and contains all the information necessary for professional technical documentation. 

 

Technical calculations begin by defining a power distribution point, which in our software is a distribution board.  

The user determines the short-circuit loop impedance in the route between the LV power-supply transformer to 

the designed distribution board. By determining the short-circuit loop impedance, in the report the user will get 

information about the calculated initial short-circuit current at the end of each circuit. 

If the designer connects an indoor power supply line to the distribution board, having output it from a connection 

(ArCADia-POWER NETWORKS plug-in), then the software will use the short-circuit loop impedance value 

calculated using the ArCADia-POWER NETWORKS software: 

 

In the distribution board the user define the demand factor and simultaneity factor values in order to determine 

the peak (active) power demand that will be present in each of the designed sections of the electrical installation. 

 

Demand factor kz is the peak power demand P0 (design power) to installed power Pi ratio: 

 

 

(1) i

z
P

P
k 0

 
 

Simultaneity factor kj is the ratio of the peak power of the indoor power supply line supplying the distribution 

board to the total of the peak powers of all the circuits output from the distribution board:  

 

(2) 







n

i

si

Owlz

OnOOO

wlz
j

P

P

PPPP

P
k

1

321

0

...

 

 

Once the designer determines the demand factor and simultaneity factor values, the software calculates the peak 

power values as per the formulas (1) and (2). 

 

Once load power [kW] calculations are completed, the software calculates the load current [A] that will be present 

in the distribution board power supply line and in all the circuits output from the switchroom.  

If the designer connects a conductor to a pre-defined single-phase consumer, the software will use the formula (4). 

If this is a three-phase design, we use the formula (3). The phase configuration of the consumer may be defined 

both in the consumer item (socket), as well as in the distribution board. 
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IL – load current present in the designed power circuit  

 

(3) 
cos3

0




N

L
U

P
I

 – three-phase load current present in a particular circuit, 

where: 

P0  – design power [Po = kz ∙ Pi], 

UN   – 400 [V] line-to-line voltage, 

cos φ  – power coefficient input by the user in the "distribution board" item. 

 

(4) 
cos

0




Nf

L
U

P
I

 – single-phase load current present in a specific circuit. 

where:  

UNf  – 230 [V] phase voltage. 

 

The next step in the calculations carried out by ArCADia-ELECTRICAL INSTALLATIONS concerns voltage 

drops in a specific circuit. To this end the software uses the following formulas: 

 

Voltage drop formula for three-phase circuits: 

 

(5) 
2

1
1%

100

N

m

i

ii

L
Us

lP

U










  

Voltage drop formula for single-phase circuits: 

 

(6) 

2

1
1%

200

Nf

m

i

ii

L
Us

lP

U










 where: 

s   –  conductor cross-section (this parameter is to be input by the designer), 

γ   –  conductor conductivity: 

 γ = 35 [m/(Ω∙mm2)] for aluminium, 

 γ = 55 [m/(Ω∙mm2)] for copper, 

li – the longest subsequent section in the circuit [m] (calculated from the previous point to the 

subsequent point under the load Pi), 

Pi – power load in the subsequent circuit point [W], 

UNf – phase voltage, i.e. 230 [V], 

UN – line-to-line voltage, i.e. 400 [V]. 

In order to calculate the short-circuit currents in a particular circuit the software first calculates the resistance RL 

(formula no. 8) and reactance XL (the software assumes that reactance for a   16 mm2 conductor is negligibly 

small) of the designed power circuit and the resulting short-circuit loop impedance ZK (formula no. 7). To this end, 

the following formulas are used: 

(7) 
    1

22

kKKK ZXRZ 
 

where: 
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Rk = 2∙RL1 + 2∙RL2 + … – sum of resistances in the individual sections of the designed installation (route between 

the distribution board and the consumer), 

RL1 – each power supply circuit has its own resistance value that depends on the conductor material (copper or 

aluminium), its cross-section and the length of the designed section, 

Zk1 – short-circuit loop impedance input by the user in the "distribution board" item that is present in the section 

between the LV power supply transformer and the distribution board or the short-circuit loop impedance value 

calculated using the ArCADia-ELECTRICAL NETWORKS software. 

 

(8) S

l
RL



  

where:  

l –  length of the power supply cable [m], 

s –  conductor cross-section (this parameter is to be input by the designer), 

γ –  conductor conductivity 

 γ = 35 [m/(Ω∙mm2)] for aluminium 

 γ = 55 [m/(Ω∙mm2)] for copper 

Xk = 2∙XL1 + 2∙XL2 + … – sum of reactances of the individual sections of the designed installation. The software 

assumes that reactance for a   16 mm2 conductor is negligibly small. 

Calculations of the initial minimum and maximum short-circuit current (single-phase short-circuit current that 

occurs in case of an L1-PE earth fault) in the particular circuits of the designed electrical installation are carried 

out based on the following formula: 

 

– Single-phase short-circuit current: 

 

(10) K

nf

fP
Z

Uc
I


1

 – initial current of the single-phase short-circuit (L1-PE short), 

 

where: 

Unf  – phase voltage in the power supply network, i.e. 230 V, 

c  – voltage factor, 

ZK  – impedance of the short-circuit loop in case of a single-phase short-circuit (L1–PE) is equal to the 

total impedances of the transformer, phase conductors and protective conductors. 

3.4 DESCRIPTION OF FACILITIES 

3.4.1 Distribution board 

Once the  icon is selected, we can add an element to the project. The designed distribution board properties 

editing window is displayed by selecting the  button or double-clicking the inserted element. 
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Fig. 6. Distribution board properties window 

First we define the visual features of the facility in the editing fields, i.e. we assign the distribution board symbol 

and the placement angle [°].  

 

In order to locate the distribution board in the 3D view the user inputs the installation height of the distribution 

board above the level of the floor in the editing field installation level [cm]. 

 

Then, using a drop-down list, we select the type of the distribution board. The following types are available, divided 

according to the installation method: 

 wall-mounted, 

 recess-mounted, 

 free-standing cabinet. 

 overhead, 

 column-mounted. 

 

The user then defines style parameters, such as: 

 

 the dimensions of the distribution board visible in the drawing are filled by the user in the editing fields: 

depth, height, width, 
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 board  IPXX protection rating: protection rating of the switchgear against the penetration of external factors. 

The IP protection marking consists of the letters IP and between two and four characters, where the first one 

indicates the protection against penetration of solids and the second one against water penetration. 

 

Entering the rated continuous current and peak current values enables ArCADia-ELECTRICAL 

INSTALLATIONS to verify whether a specific type of distribution board fulfils the conditions of the designed 

installation with respect to load and surge resistance. 

 

In case of the switchgear parameters the software automatically indicates the rated power value for the installed 

consumers supplied from the particular switchgear (it adds the installed power in each circuit output from the 

board) and calculates the average cos φ power factor for all the consumers. 

 

The designer is obligated to provide the simultaneity factor. A correct simultaneity factor depends to a great 

extent on the designer’s experience. 

 

Simultaneity factor kj is the ratio of the peak power of the indoor power supply line supplying the distribution 

board to the total of the peak powers of all the circuits output from the distribution board: 

 

The "Internal circuits" table provides information on the technical parameters of each circuit output from the 

switchgear. 

The number of the circuit is provided in the first column and this can be manipulated using the "up" and "down" 

buttons located on the right side of the table. 

The next column provides the possibility of inputting the name of the circuit, e.g. Kitchen electric sockets, Ground 

floor lighting. 

 

The subsequent columns refer to the technical parameters of the circuits, such as: 

 installed power – the installed power value defined for the consumer is displayed here. When calculating the 

installed power or lighting fixtures the software multiplies the number of light sources by the installed power 

of the fixture, 

 power factor – this is the ratio of the consumer’s active power to its apparent power. The power factor value 

is determined depending on the type of the consumer (resistance, induction, capacity). If cos φ = 1 then we are 

dealing with pure resistance, if cos φ = 0, we are dealing with pure inductance or capacity. The designer should 

assume to what extent the designed consumer uses reactive power and whether he will limit this power by 

means of any installed compensation devices. 

 demand factor – is the peak power demand P0 (design power) to installed power Pi ratio, 

 phase design – the user determines the consumer’s supply voltage Rated voltage values are: 400 V – three 

phase, 230 V – single phase). Determining the phase design enables calculating the load currents for the 

consumers, 

 protections – conductors connecting electricity consumers with the power supply source should be protected 

against the consequences of short-circuits and overloads by protective devices that trip the power supply when 

an overload or short-circuit occurs.  

The user may use a library of the most frequently employed short-circuit and overload protection measures, such 

as fuses or overcurrent circuit breakers. Protections are divided by type, kind and rated current value. Each 

protection has a short-circuit trip current value assigned for three durations: 0.2 [s], 0.4 [s], 5 [s] and a protection 

trip current value through a bimetal thermal overload release. 

In order to define a protection you need to click the field in the internal circuits table where the rated current of the 

protection is provided in the "Protections" column. Once you click it, the following window is displayed: 
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Fig. 7. Protection properties window 

The library of protective devices is contained in the "Style manager". 

Due to the broad range of protection devices available in the market, the ArCADia-ELECTRICAL 

INSTALLATIONS user can create their own protection. The user enters the name and technical parameters of 

the device, such as: protection rated current and trip current for three durations: 0.2 [s], 0.4 [s], 5 [s] and enters 

the value of multiplicity ratio for the protection device rated current in order to obtain the trip current for the 

defined protection during long-lasting overloads. The protection created by the user will be stored in the library, 

which they will be able to use when creating new designs. In order to create your own protection, click "Add 

new". 

Max. earth current cut-off time – regulations concerning the protection against electric shock (automatic 

disconnection of supply) resulting from indirect touch require that the short-circuit earth currents in networks and 

installations be tripped by protective devices within a specific period of time. The maximum permissible tripping 

times in networks depend on the rated voltage to earth and the permissible limit voltage under the particular 

environmental conditions (50 V or 25 V). 

 

Rated voltage to earth U0 

[V] 

Voltage factor c, used to calculate:  

maximum short-circuit current 

cmax
1) 

minimum short-circuit 

current cmin 

0.4 

Low voltage 400 V 0.4 0.2 

Table 3. Permissible tripping times for earth short-circuits in TN networks 

 

In certain circumstances (mostly in outdoor networks), longer tripping times than those provided in table 2 are 

allowed, however not longer than 5 seconds. 

 

Variant 1 – drawing the cabling installation 

 

In order to design an indoor electrical installation using the cabling drawing method you need to use the ArCADia-

ELECTRICAL INSTALLATIONS toolbar and then select and insert the necessary items into the project. The 
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user may employ such elements as: distribution board, electric socket, lighting fixture, connector, electric gang 

box and ceiling cable conduit. Editing the items mentioned above is discussed further on in this manual. 

 

 
 

Fig. 8. ArCADia-ELECTRICAL INSTALLATIONS toolbar 

 

After inserting items the user should route a conductor between the distribution board and the particular consumers. 

To do that, select the Insert electric cable  icon from the ArCADia-ELECTRICAL INSTALLATIONS 

toolbar. A more precise description of this item can be found in item 3.4.5. of this manual. The Element detection 

option will prove useful while connecting items. The user can activate it by selecting the Electric cable item in the 

conductor routing settings window. 

 

 
 

Fig. 9. Electric conductor item insertion bar 

 

Item detection facilitates the designer to find the end of a particular item to which a conductor can be connected. 

When drawing this option is visible as a temporary cross that appears while the designer wants to connect a 

conductor to an element. This option helps to assure the designer that the conductor was connected to the 

appropriate element. Other options, such as elements tracking and conductor detection are described in item 3.4.5. 

The item connection method is presented in Figure 3. In that case the G1 electric socket is connected to the TR1 

distribution board. The procedure is the same in case of other items. The arrow points to the temporary cross, i.e. 

the element detection. After selecting an electrical conductor the user has to point the mouse cursor to the 

distribution board and a detection cross will appear. This procedure ensures that the conductor will be connected 

to the TR. After clicking the mouse button and connecting the conductor, the user may route the conductor to a 

consumer. While approaching the electric socket with a conductor, a temporary detection cross, marked with an 

arrow in Figure 4, will appear in the anchor point. Click the mouse and the items will be connected to each other. 

After connecting the items correctly, an information box will appear next to the electric socket symbol, telling you 

which distribution board and which circuit the electric socket was connected to.  
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Fig. 10. Connecting an electric conductor to a distribution board 

 

 
 

Fig. 11. Connecting an electric conductor to an electric socket 

The user may review the created circuits. To do this the user should select the Go to the properties dialogue in the 

Distribution board action bar. 
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Fig. 12. Distribution board action bar, Go to the properties dialogue 

 

In the Element properties window: Distribution board, all the circuits created by the designer while connecting 

items will appear in the Internal circuits item. The user may set their names and change their parameters, such as 

the installed power (installed power is automatically imported from the consumer’s rated power), power factor, 

demand factor, phase design and protection. Information about the distribution board can be found in section 3.4.1 

of this manual. 

 
 

Fig. 13. Element properties window: Distribution board 
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Variant 2 – addressing consumers 

 

In order to design an internal electrical installation using the addressing method, the user has to select the Insert 

distribution board  icon from the ArCADia-ELECTRICAL INSTALLATIONS toolbar. 

 

 

 

Fig. 14. ArCADia-ELECTRICAL INSTALLATIONS toolbar 

 

Next, insert a distribution board into the project and click the left mouse button on the item to open the Distribution 

board action bar. 

 

 

Fig. 15. Distribution board action bar 

 

Select and click the Internal circuit manager icon on the Distribution board action bar. 

 

 

Fig. 16. Distribution board action bar, Internal circuit manager icon 

An Internal circuit manager window will appear. Using the Add  button with a green plus the user can insert 

more circuits into the list. Apart from creating a circuits list the user may input their characteristics in the 

subsequent columns (name, installed power, power factor, demand factor, phase design, protection, electric 

conductor). 

 

Fig. 17. Internal circuit manager window 
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The electrical installation designer may open the Internal circuit manager window at any given time and add a new 

circuit, delete or edit an existing one and they do not have to insert all the circuits at once. Assigning electrical 

circuits to inserted electrical items is done through the Element properties window. This process was described on 

the example of an electric socket. 

 

 

 

Fig. 18. Element Properties window: Socket 

 

The software gives the user a possibility to assign one or more sockets simultaneously to a selected circuit. To 

assign a socket to a defined circuit the user has to select the desired items in the project. The user can do that by 

selecting one item, selecting/marking several items simultaneously or by using the Project manager, select all the 

sockets or sockets from one of the previously defined groups, e.g. sockets that are in a particular room. After 

selecting a socket or sockets in the project, the user has to select Go to the properties dialogue from the Socket 

action bar. 

 

Fig. 19. Socket action bar 

 

Next, from the Element properties window: Socket in the Circuit field: open the list and select a particular circuit 

to which the selected elements will be assigned. 

 



ArCADia-ELECTRICAL INSTALLATIONS         User Manual 
Working with the software 

 

27 

 

Fig. 20. Element properties window: Socket, electrical circuits list 

 

To select items through the Project manager, choose the ArCADia item from the menu. Next, click the Show/Hide 

icon in the Project manager. 
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Fig. 21. Project Manager window 

 

In the project manager tree the user should select the items that they want to select in the project and click the 

Select items  icon. After that proceed as in the example mentioned above. After correctly assigning items to a 

circuit, information about the distribution board and circuit that were assigned to the item will appear next to the 

item symbol (for example G1 socket). 

 
 

Fig. 22. Symbol of a socket without a distribution board or circuit assigned 

 
 

Fig. 23. Symbol of a socket with a TR1 distribution board and circuit 1 assigned 

3.4.2 Electric socket 

Once the  icon is clicked, we can add an element to the project. The electric socket properties editing window 

is displayed by selecting the  button or double-clicking the inserted element. 

 



ArCADia-ELECTRICAL INSTALLATIONS         User Manual 
Working with the software 

 

29 

 

Fig. 24. Electric Socket properties window. 

 

In the first stage of designing an electric socket the user starts by defining the visual characteristics of the socket 

[pens, fonts], its angle on the drawing and assignment to the actual path. 

 

Symbol – the symbol shown next to the item on a drawing. The user can define the item’s symbol and ordinal 

number. 

 

Pens – setting the visual characteristics of an item, such as the contour line type and its colour. 

 

Fonts – used mainly to set the item’s description (font colour, type and size). 

 

Actual route – selecting the actual route is possible when the designer draws the route on the building’s 

architectural projection. 

Assigning an item to a particular route allows the user to manage its position during a 3D visualisation. 

Next, the item’s parameters should be determined: 

 

- consumer installed power – depending on the purpose of a particular socket, the designer should assume the 

type of the device connected to the socket and its rated active power. The designers usually assume that the general 

purpose socket is loaded with 300 W power. If the user installs it with a particular purpose in mind, they should 

mark its power on a nameplate [W]. 

 

In order to put a socket in the 3D view the user should determine the socket installation height above the floor, i.e. 

the installation level [cm]. 

 

Distribution board – in this field the designer sets the name of the distribution board from which the consumer 

is powered. This feature is used when the user is designing an installation using the addressing method, i.e. without 
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routing the conductors. When the user is routing insulated and sheathed conductors, the distribution board name 

is automatically assigned to a consumer when the conductor is connected. 

 

Circuit – this is the number of a circuit that will power a particular socket. When routing conductors the circuit 

number is automatically assigned to a socket item when the conductor is connected to a socket.  

 

Next, the user defines the style parameters that generally constitute the characteristics and properties of a socket 

item, such as: 

 

 Type – generally determines the design of the desired socket. Selecting a desired socket type will cause a pre-

determined type symbol to appear in the drawing. 

 

 installation method – defines the socket type based on its installation method, 

 

 tightness and grounding – these are included by ticking the appropriate field to select which of the grouped 

options will be taken into consideration by the software. Selecting one option influences the symbol that will 

be displayed in the drawing. 

 

 socket protection level IPXX – level of protection against the penetration of external factors. The IP 

protection marking consists of the letters IP and between two and four characters, where the first one indicates 

the protection against penetration of solids and the second one against water penetration. 

 

 phase design – the user determines the consumer’s supply voltage (400 V – three phase, 230 V – single phase). 
Determining the phase design enables calculating the load currents for the consumers. 

 

 number of pins – determines the number of pins in a socket, 

 

 rated current – determines the maximum load current with which a particular socket can operate. Exceeding 

that value will cause the equipment to malfunction, change the parameters or get damaged. 

3.4.3 Lighting fixture 

Once the  icon is clicked, we can add an element to the project. The lighting fixture properties editing window 

is displayed by selecting the button  or double-clicking the inserted element. 
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Fig. 25. Lighting fixture properties window 

 

In the first stage of designing a lighting fixture the user starts by defining the visual characteristics of the fixture 

[pens, fonts], its angle on the drawing and assignment to the actual path. 

Symbol – the symbol shown next to the item on a drawing. The user can define the item’s symbol and ordinal 

number. 

 

Pens – setting the visual characteristics of an item, such as the contour line type and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Actual route – selecting the actual route is possible when the designer draws the route in the architectural 

projection of the building. 

 

Assigning an item to a particular route allows the user to manage its position during a 3D visualisation.  

 

Next, the item’s parameters should be determined: 

 

In order to locate a fixture in the 3D view the user inputs the height above the floor, i.e. the installation level [cm]. 

 

Distribution board – in this field the designer sets the name of the distribution board from which the consumer 

is powered. This feature is used when the user is designing an installation using the addressing method, i.e. without 

routing the conductors. When the user is routing insulated and sheathed conductors, the distribution board name 

is automatically assigned to a consumer when the conductor is connected. 
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Circuit – this is the number of a circuit that will power a particular fixture. When routing conductors the circuit 

number is automatically assigned to a fixture when the conductor is connected to it. 

 

Next, the user defines the style parameters that generally constitute the characteristics and properties of a lighting 

fixture item, such as: 

 

Fixture type – the software uses the most popular fixture types used for lighting designs in buildings with various 

purposes. 

 home fixture used in single-family housing, 

 fluorescent fixture most commonly used in public buildings, 

 "downlight" fixture installed in representative buildings where room aesthetics is required, 

 high bay lamp used mainly to illuminate industrial buildings, such as industrial halls, 

 exit fixture installed to ensure a proper escape route from a building. After selecting an exit fixture from the 

drop-down list, a "pictogram" bookmark will appear on the right side of the window. The user may choose 

the selected pictogram (a drawing reflecting the direction of the proper escape route in case of fire) by clicking 

it with the mouse. 

 lighting outlet – depicts the ending of an insulated and sheathed conductor to which the contractor can connect 

any fixture. 

 

Next, using the drop-down list, the user defines the installation method for a given fixture: 

 built-in – a method used mainly in case of suspended ceilings, 

 ceiling-mounted – installation on a ceiling using appropriate light battens, 

 pendant – fixtures hanging down on suspension cables or appropriate chains. After the user selects the pendant 

installation type, an editing field will appear in the dialogue box, allowing the user to set the fixture suspension 

cable length [cm]. 

 

Next, using the drop-down list, the designer sets the light source for the fixture. For every type of fixture the 

software selects a light source type that is usually installed by lamp manufacturers. 

 

After selecting a desired fixture type, installation type and light source type, the user sets the light sources number 

in an editing field. 

During the technical calculations carried out by the software, the number of light sources will be multiplied by the 

fixture installed power. Due to the rich variety of equipment available for the modern lighting fixtures, the program 

does not account for the power loss in a fixture (the software does not calculate the actual power used by the 

fixture). 

 

There are two selection fields in the lighting fixture dialogue box: emergency module and raster reflector. 

By selecting one of the fields the user defines the equipment of the fixture. Selecting the emergency module field 

causes the designed fixture to be equipped with an emergency module to guarantee that the fixture will operate 

properly in case of a power failure. The user sets the module type from a drop-down list depending on how long a 

given fixture can maintain voltage. 

By ticking the "raster reflector" field you can equip the designed fixture with a reflector. 

 

– fixture IPXX protection rating: protection rating of the lighting fixture against the penetration of external factors. 

The IP protection marking consists of the letters IP and between two and four characters, where the first one 

indicates the protection against penetration of solids and the second one against water penetration. 

3.4.4 Electric switch 

Electric switch is an electric switch designed to enable or disable the operating current in low voltage installations, 

e.g. lighting installations. 

http://pl.wikipedia.org/wiki/%C5%81%C4%85czniki_elektryczne
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Once the  icon is clicked, we can add an element to the project. The electric switch properties editing window 

is displayed by selecting the  button or double-clicking the inserted element. 

 

Fig. 26. Electric switch properties window 

In the first stage of designing a switch the user starts by defining the visual characteristics of the fixture [pens, 

fonts], its angle on the drawing and assignment to the actual path. 

 

Symbol – the symbol shown next to the item on a drawing. The user can define the item’s symbol and ordinal 

number. 

 

Pens – setting the visual characteristics of an item, such as the contour line type and its colour. 

 

Fonts – used mainly to set the item’s description (font colour, type and size). 

 

Actual route – selecting the actual route is possible when the designer draws the route in the architectural 

projection of the building. 

Assigning an item to a particular route allows the user to manage its position during a 3D visualisation. 

 

Next, the item’s parameters should be determined: 

 

In order to locate a fixture in the 3D view the user inputs the height above the floor, i.e. the installation level [cm]. 

 

Distribution board – in this field the designer sets the name of the distribution board from which the conductor 

to the switch is routed. This feature is used when the user is designing an installation using the addressing method, 

i.e. without routing the conductors. When the user is routing insulated and sheathed conductors, the distribution 

board name is automatically assigned to a switch when the conductor is connected. 
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Circuit – this is the number of a circuit that will be controlled by the particular switch. When routing conductors 

the circuit number is automatically assigned to a switch when the conductor is connected to it. 

 

Next, the user defines the style parameters that generally constitute the characteristics and properties of an electric 

switch item, such as: 

The designer can select the switch Type from a drop-down list. The software uses most electric switch types used 

for lighting control design in buildings of various purposes: single switch, candle stick switch, stair switch, 

crossover switch, double-push switch, tie switch. 

 

Number of poles in a switch is selected from a drop-down list. Number of poles determines the number of phase 

conductors output from the switch. The software allows the user to select one, two or three pole electric switches. 

 

Tightness, lighting and dimmer – after the user ticks a particular field corresponding to one of the grouped 

characteristics of a switch, the software selects which of them will be taken into consideration in the project. 

Selecting one option influences the switch symbol that will be displayed in the drawing. 

 

The switch dimensions depicted on drawing can be set by the user by means of filling the appropriate editing 

fields: depth [cm], height [cm], width [cm]. 

 

Fixture IPXX protection rating: protection rating of the lighting fixture against the penetration of external factors. 

The IP protection marking consists of the letters IP and between two and four characters, where the first one 

indicates the protection against penetration of solids and the second one against water penetration. 

3.4.5 Electric conductor 

After clicking the  icon a dialogue box with the conductor drawing settings will appear. In that box the 

user can add an item to the project and define the drawing settings. 

 

 

Fig. 27. Conductor routing settings window 

 

On the left side of the window there are three selection fields, i.e. item tracking, element detection and 

conductor detection. 

 

Elements tracking – facilitates locating items on a drawing between the last point of a the conductor being drawn 

and an item in a straight line. Tracking is determined by a set of temporary sections that appear when the software 

finds a straight line between the conductor and an item. 

The elements tracking feature ensures that right angles are maintained quickly and seamlessly while drawing the 

wiring of a building. 

 

Item detection – facilitates locating the end of a particular item to which a conductor can be connected. Element 

detection is marked by a temporary cross that appears when the designer tries to connect a conductor to an element. 

Item detection assures the designer that the conductor was connected to an element. 
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Conductor detection – allows the designer to connect the conductor being designed to a conductor and extend 

the designed circuit. Conductor detection is marked by a temporary cross that appears when the designer tries to 

connect a conductor to the conductor being drawn. Conductor detection assures the designer that the conductor 

was connected to a circuit. 

 

The electric conductor properties editing window is displayed by selecting the  button or double-clicking the 

inserted element. 

 

Fig. 28. Electric conductor properties window 

 

DESCRIPTION OF ELECTRIC CONDUCTOR PARAMETERS: 

 

Conductor route length – this is the length of an electric conductor section drawn by the designer (line length in 

the drawing). 

 

Length – this is a parameter defining the total length of the designed circuit, i.e. taking into account the bends and 

vertical sections not shown in the drawing. This value is adopted by the software for technical calculations. 

 

Ambient temperature [°C] – this is the temperature of the surrounding environment when the analysed conductor, 

which is located in this environment, is not under load. 

 

Conductor laying method – the method of laying a conductor is the parameter that influences the definition of 

the continuous current-carrying capacity of a specific conductor. The software provides the conductor laying 

methods most frequently used by contractors.  
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Conductor metal – suitable electricity conductors are usually aluminium or copper. Aluminium has a lower 

electric conductivity in comparison with copper (γAl = 35 
2mm

m


, γCu = 55 

2mm

m

  ), but it is a metal 

significantly cheaper than copper.  

 

Conductor insulation – insulation separates conductor cores from one another and from other earthed elements, 

protects the conductors against adverse weather conditions and prevents people from touching a wire without 

insulation. Conductor insulation is usually made of polyvinyl chloride (plasticised PVC – limit temperature 70 °C) 

or cross-linked polyethylene (XLPE, limit temperature 90 °C). 

Number of cores – the number of conductors that conduct electric current (phase conductors) along with the 

neutral or protective conductor. 

Conductor cross-section – the user may use standard conductor core cross-sections. The conductor cross-section 

is an important parameter, influencing the calculations of short-circuit currents and voltage drops. 

Conductor type – power supply conductors may be routed in a single multi-core cable or a bundle of single-core 

cables. The cable type that we will use influences the continuous current-carrying capacity of the designed buried 

line. 

3.4.6 Distribution box 

After clicking the icon  a dialogue box will appear where you can change the settings of the distribution box 

inserted into the drawing: 

 

Fig. 29. Distribution box insertion properties window 

On the left side of the window there are two selection fields, i.e. item tracking and conductor detection. 

 

Item tracking – facilitates locating a distribution box in the drawing for the designer. Tracking is determined by 

a set of temporary sections that appear when the software locates a straight line between the distribution box and 

the item. 

Item tracking facilitates the quick and efficient drawing of an installation for the designer. 

 

Conductor detection – enables the designer to connect the designed box with the conductor and enables a more 

efficient extension of the electric circuit. Conductor detection is marked by a temporary cross that appears when 

you try to connect a box to the drawn conductor. Conductor detection assures the designer that the particular box 

was connected to the circuit. 

 

The electric conductor properties editing window is displayed by selecting the  button or double-clicking the 

inserted element. 
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Fig. 30. Distribution box properties window 

In the first phase of determining a box the user starts with the appearance features [pens, fonts] and the actual 

route. 

 

Symbol – the symbol displayed at the item in the drawing. The user can define the item’s symbol and ordinal 

number. 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Actual route – selecting the actual route is possible when the designer draws the route in the architectural 

projection of the building. 

Assigning an item to a particular route allows the user to manage its position during a 3D visualisation. 

 

Next, the item’s parameters should be determined: 

In order to locate a distribution box in the 3D view the user inputs the height above the floor, i.e. the installation 

level [cm]. 

The distribution box is inserted at all intersections of electric conductors. 

3.4.7 Ceiling cable conduit 

After clicking the  icon a dialogue box with the settings for inserting a ceiling cable conduit into the 

drawing is displayed (a site where you can route the conduct to the upper or lower level): 
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Fig. 31. Ceiling cable conduit settings window 

 

On the left side of the window there are two selection fields, i.e. item tracking and conductor detection. 

 

Item tracking – facilitates locating a cable conduit in the drawing for the designer. Tracking is determined by a 

set of temporary sections that appear when the software locates a straight line between the cable conduit and the 

item. 

Item tracking facilitates the quick and efficient drawing of an installation for the designer. 

 

Conductor detection – enables the designer to locate the designed cable conduit at the end of a conductor and 

efficiently extent the electric circuit. Conductor detection is marked by a temporary cross that appears when you 

try to connect a box to the drawn conductor. Conductor detection assures the designer that the particular box was 

connected to the circuit. 

 

The ceiling cable duct properties editing window is displayed by selecting the  button or double-clicking the 

inserted element. 

 

 

Fig. 32. Ceiling cable conduit properties window 

 

In the first phase of determining a cable conduit the user starts with the appearance features [pens, fonts] and the 

actual route. 

 

Symbol – the symbol displayed at the item in the drawing. The user can define the item’s symbol and ordinal 

number. 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Actual route – selecting the actual route is possible when the designer draws the route in the architectural 

projection of the building. 

Assigning an item to a particular route allows the user to manage its position during a 3D visualisation.  



ArCADia-ELECTRICAL INSTALLATIONS         User Manual 
Working with the software 

 

39 

 

Next, the item’s parameters should be determined: 

 

In order to define the direction of routing electric conductors through the cable conduit you can use a drop-down 

list in the "direction" tab. 

Distribution board – in this field the designer assigns a name to the distribution board from where the particular 

conductor (circuit) that goes through the designed cable conduit is output. 

 

Circuit – this is the number of the circuit that goes through the designed ceiling cable conduit. 

 

Inserting a ceiling cable conduit in the subsequent views. 

 

If the subsequent levels of the building are located next to each other in the design (e.g. in AutoCAD), inserting a 

ceiling cable conduit into the level above or below is done as follows. 

 

Open the Project Manager window and select the Insert projection icon. 

 

 

Fig. 33.  Project Manager window, inserting a projection 

Then insert the view anchor in a characteristic point of the project (a location that is repeated on the particular 

levels). This can be an element of the building, so that it is easier to locate the place on the subsequent levels. 
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Fig. 34. View anchor 

 

After inserting the level view anchor, the user may insert a ceiling cable conduit into the project by selecting the 

appropriate icon from the ArCADia-ELECTRICAL INSTALLATIONS toolbar. 

 

 

 

Fig. 35. ArCADia-ELECTRICAL INSTALLATIONS toolbar, ceiling cable conduit 

 

For the inserted ceiling cable conduit to be visible in the level above or below you need to add the level above 

below or below using the Project manager, in accordance with the direction in which the conduit was inserted. In 

the Project manager window select the Add level above icon. 
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Fig. 36. Project Manager window, adding levels 

After inserting a new level above you need to move to the view of the subsequent level and insert a view anchor 

in exactly the same place as in the previous drawing. After doing this the ceiling cable conduit icon will appear.  

3.4.8 Cable tray 

After clicking that icon a dialogue box that contains the insertion settings for a cable tray will appear: 

 

Fig. 37. Cable tray drawing settings and properties window 

In the upper part of the window the user may select the cable route drawing characteristics: 

 

Elements detection – while drawing the route this option facilitates placing a particular route element (three-way 

fittings, four-way fittings, reducers, elbows, arches) and allows for a fast and seamless extension. Element 

detection is marked by a temporary cross that appears when the designer tries to connect another conductor route 

section to an existing route element. 
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Sections detection – while drawing the route this option facilitates placing the desired route section and allows 

for a fast and seamless extension. Section detection is marked by a temporary cross that appears when the designer 

tries to connect another conductor route section to an existing route section. 

 

Item tracking – facilitates locating a cable tray in the drawing for the designer. Tracking is determined by a set 

of temporary sections that appear when the software finds a straight line (tray structural axis) of the tray route 

section. 

Item tracking facilitates the quick and efficient drawing of cable routes for the designer. 

 

Section end tracking – facilitates locating a cable route section ending on a drawing. Tracking is determined by 

a set of temporary sections that appear when the software finds a point that determines the end of the drawn route. 

Section end tracking facilitates the quick and efficient drawing of cable routes for the designer. 

 

The estimated initial and final height of the designed route section are provided in the window below. This enables 

the user to design vertical cable routes. 

 

The cable route properties editing window is displayed by selecting the  button or double-clicking the 

inserted element. 

 

 

Fig. 38. Cable tray properties window 

In the first phase of determining a cable tray the user starts with the appearance features (appearance, description, 

pens, fonts): 
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Description appearance – settings for the descriptions visible at the item in the drawing. The user may define 

description elements, e.g. the name of the item and dimensions. 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Next, the item’s parameters should be determined: 

 

Height 1 – here the designer assigns the initial height (installation level) for the designed cable tray. 

 

Height 2 – here the designer assigns the final height (installation level) for the designed cable tray. 

 

Length – here the designer independently calculates and presents the length of the designed tray route section. 

 

Fitting spacing – among others, the designer defines the distances between the subsequent fittings of the tray. The 

number of supporting elements for the tray will be listed in the material list. 

 

Then, by clicking the button , you can add circuits laid in the designed section of the cable tray.  

 

In order for the user to be able to add circuits, the electrical installation must be designed using the addressing 

method, i.e. in the building where the cable route system is being designed there needs to be a previously designed 

electrical installation (sockets and lighting), without the need to draw conductors. 

After introducing all the conductors into the designed cable tray the software calculates the following parameters: 

 

Load – here the software displays the weight [kg] of the laid wiring per linear meter of the tray. The load is 

calculated only when the user determines the weight of the electric conductor when defining it. 

 

Filling – in this field the software indicates the percentage of filling the usable cable tray area. The filling will 

only be calculated if the user determines the internal diameter of the electric conductor when determining the 

circuit. 

 

Then we set the style parameters for the designed consumer: 

 

Type – that is the type of design and structure of the tray: non-perforated, perforated, mesh. 

 

Material – what material the designed tray should be made of. 

 

Width – width of the designed tray. This influences the filling of the tray. 

 

Height – height of the designed tray. This influences the filling of the tray. 

3.4.9 Cable ladders 

After clicking that icon a dialogue box that contains the insertion settings for a cable ladder will appear: 
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Fig. 39. Cable ladder drawing settings and properties window 

In the upper part of the window the user may select the cable route drawing characteristics: 

 

Elements detection – while drawing the route this option facilitates placing a particular route element (three-way 

fittings, four-way fittings, reducers, elbows, arches) and allows for a fast and seamless extension. Element 

detection is marked by a temporary cross that appears when the designer tries to connect another conductor route 

section to an existing route element. 

 

Sections detection – while drawing the route this option facilitates placing the desired route section and allows 

for a fast and seamless extension. Section detection is marked by a temporary cross that appears when the designer 

tries to connect another conductor route section to an existing route section. 

 

Item tracking – facilitates locating a cable ladder in the drawing for the designer. Tracking is determined by a set 

of temporary sections that appear when the software finds a straight line (ladder section structural axis). 

Item tracking facilitates the quick and efficient drawing of cable routes for the designer. 

 

Section end tracking – facilitates locating a cable route section ending on a drawing. Tracking is determined by 

a set of temporary sections that appear when the software finds a point that determines the end of the drawn route. 

Section end tracking facilitates the quick and efficient drawing of cable routes for the designer. 

 

The estimated initial and final height of the designed route section is provided in the window below. This enables 

the user to design vertical cable routes. 

 

The cable route properties editing window is displayed by selecting the  button or double-clicking the 

inserted element. 
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Fig. 40. Cable ladder properties window 

In the first phase of determining a cable ladder the user starts with the appearance features (appearance, description, 

pens, fonts): 

 

Description appearance– settings for the descriptions visible at the item in the drawing. The user may define 

description elements, e.g. the name of the item and dimensions. 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Next, the item’s parameters should be determined: 

 

Height 1 – here the designer assigns the initial height (installation level) for the designed cable ladder. 

 

Height 2 – here the designer assigns the final height (installation level) for the designed cable ladder. 

 

Length – here the designer independently calculates and presents the length of the designed ladder route section. 

 

Fitting spacing – among others, the designer defines the distances between the subsequent fittings of the ladder. 

The number of supporting elements for the ladder will be listed in the material list. 

 

Then, by clicking button , you can add circuits laid in the designed section of the cable ladder. 
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In order for the user to be able to add circuits, the electrical installation must be designed using the addressing 

method, i.e. in the building where the cable route system is being designed there needs to be a previously designed 

electrical installation (sockets and lighting), without the need to draw conductors. 

 

After introducing all the conductors into the designed cable ladder the software calculates the following 

parameters: 

 

Load – here the software displays the weight [kg] of the laid wiring per linear meter of the ladder. The load is 

calculated only when the user determines the weight of the electric conductor when defining it. 

 

Filling – in this field the software indicates the percentage of filling the usable cable ladder area. The filling will 

only be calculated if the user determines the internal diameter of the electric conductor when determining the 

circuit. 

 

Then we set the style parameters for the designed consumer: 

 

Material – what material the designed ladder should be made of. 

 

Width – width of the designed ladder. This influences the filling of the ladder. 

 

Height – height of the designed ladder. This influences the filling of the ladder. 

3.4.10 Cable conduit 

After clicking that icon a dialogue box that contains the insertion settings for a cable conduit will appear: 

 

 

Fig. 41. Cable conduit drawing settings and properties window 

In the upper part of the window the user may select the cable conduit drawing characteristics: 

 

Elements detection – while drawing the route this option facilitates placing a particular route element (three-way 

fittings, four-way fittings, reducers, elbows, arches) and allows for a fast and seamless extension. Element 

detection is marked by a temporary cross that appears when the designer tries to connect another conductor route 

section to an existing route element. 

 

Sections detection – while drawing the route this option facilitates placing the desired route section and allows 

for a fast and seamless extension. Section detection is marked by a temporary cross that appears when the designer 

tries to connect another conductor route section to an existing route section. 

 

Item tracking – facilitates locating a cable conduit in the drawing for the designer. Tracking is determined by a 

set of temporary sections that appear when the software finds a straight line (conduit section structural axis). 

Item tracking facilitates the quick and efficient drawing of cable routes for the designer. 

 

Section end tracking – facilitates locating a cable route section ending on a drawing. Tracking is determined by 

a set of temporary sections that appear when the software finds a point that determines the end of the drawn route. 
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Section end tracking facilitates the quick and efficient drawing of cable routes for the designer. 

 

The estimated initial and final height of the designed route section is provided in the window below. This enables 

the user to design vertical cable routes. 

 

The cable route properties editing window is displayed by selecting the  button or double-clicking the 

inserted element. 

 

 

Fig. 42. Cable conduit properties window 

 

In the first phase of determining a cable conduit the user starts with the appearance features (appearance, 

description, pens, fonts): 

 

Description appearance– settings for the descriptions visible at the item in the drawing. The user may define 

description elements, e.g. the name of the item and dimensions. 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

Next, the item’s parameters should be determined: 

 

Height 1 – here the designer assigns the initial height (installation level) for the designed cable conduit. 
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Height 2 – here the designer assigns the final height (installation level) for the designed cable conduit. 

 

Length – here the designer independently calculates and presents the length of the designed conduit route section. 

 

Fitting spacing – among others, the designer defines the distances between the subsequent fittings of the conduit. 

The number of supporting elements for the conduit will be listed in the material list. 

 

Then, by clicking button , you can add circuits laid in the designed section of the cable conduit. 

 

In order for the user to be able to add circuits, the electrical installation must be designed using the addressing 

method, i.e. in the building where the cable route system is being designed there needs to be a previously designed 

electrical installation (sockets and lighting), without the need to draw conductors. 

 

After introducing all the conductors into the designed cable conduit the software calculates the following 

parameters: 

 

Load – here the software displays the weight [kg] of the laid wiring per linear meter of the conduit. The load is 

calculated only when the user determines the weight of the electric conductor when defining it. 

 

Filling – in this field the software indicates the percentage of filling the usable cable conduit area. The filling will 

only be calculated if the user determines the internal diameter of the electric conductor when determining the 

circuit. 

 

 

Then we set the style parameters for the designed consumer: 

 

Material – what material the designed conduit should be made of. 

 

Width – width of the designed conduit. This influences the filling of the conduit. 

 

Height – height of the designed conduit. This influences the filling of the conduit. 

3.4.11 Dialux export and import 

When designing workplace or public areas lighting it is necessary to design the lighting system in accordance with 

the PN-EN 12464-1: 2004: "Light and lighting. Workplace lighting" standard. 

 

In each room’s properties the user may define the required illumination level and once calculations in Dialux are 

carried out, he will also obtain the design illumination level: 
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Fig. 43. Room properties window 

 

 

In the window above you can define the required illumination level [lx] for the particular room. 

After clicking the "Export to Dialux" icon the following window is displayed: 
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Fig. 44. Window for selecting rooms to be exported to Dialux. 

In this window you can define which rooms would be exported into Dialux. Export consists in transferring the 

entire architecture (room height, room dimensions, room shape). Once the items for transfer are defined you click 

the "OK" button and the following window appears: 

 

 

Fig. 45. Save STF file window 

Input the file name and the path to save it under. Then you click the Save button and Dialux opens automatically 

with the transferred rooms to be designed. 

Having the contour of the selected rooms ready, Dialux enables quickly and easily designing the lighting system 

and carrying out calculations. 

Once the lighting system is designed you can save the file (the STF format), and then by clicking the "Import from 

Dialux" icon you can import all the designed fixtures into the building’s projection. You can also import the 

necessary parameters, i.e.: 

Average illumination level – the calculated average illumination level for all the designed rooms is imported into 

the software. 

Fixture power – the installed power value [W] for the fixture is imported into the software. 

Using the "Room list" feature the designer may list all the rooms in the designed building in a table, along with 

the necessary illumination level for each room and the average illumination level [lx] calculated in Dialux. 
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3.4.12 Electrical installations item list 

After clicking on the  icon, a partial list of selected (on the projection) elements may be inserted. A table with 

a list of those elements is displayed and it may be inserted into the drawing by clicking the mouse on the screen. 

The table contains a list of all the symbols, names, markings and quantities of the items used in the projection by 

the user. 

 

Double-clicking a table inserted into the drawing opens the item properties window. 

 

 

 

Fig. 46. Electrical installation elements list properties window 

In the table the user defines the visual parameters of the table [pens, fonts] and its contents, i.e. ticks the boxes 

next to the elements to be displayed in the table (symbol, marking, quantity, name). 

 

Pens – setting appearance features for the item, such as the type of item contour line and its colour. 

 

Fonts – these are used mainly to determine the item’s description (font colour, type and size). 

 

3.4.13 Changing views of 2D items 

Each item in the ArCADia-ELECTRICAL INSTALLATIONS module has its own predefined 2D symbol 

(appearance) on the projection. The user may change this view into one created by themselves using the view 

change feature. The "Change item 2D appearance"    icon is available in the item properties window in the View 

control group. 
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Fig. 47. "Change item 2D appearance" icon location properties window 

After clicking the icon the user gains access to the 2D appearances library. Folders and sub-folders contain the 

appearances of typical electric devices. 

 

Fig. 48. 2D item appearance selection window 

The user can draw the appearance of a 2D item themselves and save it in the 2D item library using the (Item 

explorer). 



ArCADia-ELECTRICAL INSTALLATIONS         User Manual 
Working with the software 

 

53 

Once a view is inserted using ArCADia-INTELLICAD or AutoCAD, click the  icon in order to name the newly 

created 2D item and then select an area on the projection where the item has been drawn. It will be added to the 

user’s elements folder. From there on it will be available in the element properties and can be used to change the 

2D item appearance. 

3.4.14 Editing and introducing types. 

To display the Type library editor dialog box, click the icon: 

ArCADia software: 

After clicking the icon: The System ribbon  Type library icon   

 

AutoCAD or ArCADia-INTELLICAD software: 

After clicking the icon: Electric installations   toolbar 

 

or type ISA_ETL 
 

The Type library editor is used to edit and introduce new item types into the ArCADia software. It facilitates 

access to manufacturers catalogues and enables selecting only those catalogues which the user uses most often 

when designing. Additionally, types are divided into a Standard library (i.e. the library provided with a given 

software version) and a User library, where all the new or user modified element types are saved. 

 

 
Fig. 49. Type editor window 
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In the upper part of the type editor window, the user may select a branch from the drop-down list where all the 

branch-modules available in ArCADia BIM system are listed. 

 

 

Fig. 50. Drop-down list view of the branches available in the ArCADia BIM system 

After selecting the appropriate branch the user has access to all the items, e.g. electric conductor, available in the 

selected branch (module) from the Elements drop-down list (on the right side).  

 

 

After clicking on the selected element in the Global library all element types will be available. During the first 

run it will be the types available in the software by default. During the design process you may add additional 

types into the libraries. During the first run it will be the Standard library types (files provided with a given 

version of the software). During the design process you may add additional types into the libraries, creating a User 

library. 

 

 

Lower part of the editor window is divided into the Global Library page (left) and Design Library page (right). 

Global library – where all the default element types available for the user and the elements added when working 

with the software are added. divided into a Standard library (the library provided with a given version of the 

software, which the user does not change) and a User library, which contains elements (types) saved by the user 

when working with the software. 

 

Project library – this is the place where all the element types available for use in the project are listed. In other 

words: those element types which are available in the properties window of each item: 

 

 

Fig. 51. Type insertion from the level of item properties 

and in the modification and insertion windows. 

 

 

Fig. 52. Type entry point from the element modification and insertion window level 
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Above the type library windows there are icons with the following functions: 

Add new type  – after clicking this icon the user may add a new type to the Global library or the Project 

library. Type properties for the particular element, where the user may determine all the parameters of the element 

that are characteristic for it are, among others, the type parameters, view. 

 

Note!!! Clicking the Add new type icon when a type has been previously highlighted in the Library will add a 

new type based on the highlighted one. This facilitates entering a catalogue of items to the library, e.g. supplied 

by one company, where the only distinctive feature is e.g. the diameter. 

 

Add new folder  – after clicking this icon the user may add a new folder, where he can then later add element 

types. A window prompting for the folder name will appear. After entering the folder name you need to press the 

 button in order to add the folder to the library or  to cancel the command. 

 
Fig. 53. Folder types insertion window 

Delete  – after clicking this icon the user may delete the selected type or folder. 

Type properties  – after clicking this icon the user will have access to the properties of the selected type. He 

can edit and save these values here.  

Leave only the types used in the project  – after clicking this icon in the Project library, only the types used 

in the project (used in any object in the project) will remain visible. 

 

After clicking a type with the right mouse button, a menu becomes available: 

 

 
 

Type properties – works the same as the icon described above. 

Copy – copies the type. 

Paste – pastes a previously copied type and inserts it with the same name and subsequent number. 

Rename – the user may rename an already inserted type. 

Delete – works the same as the icon described above. 

 

Above the project library there is the  button. Once you click this button the Project 

library settings will be saved in the template and will be accessible for future projects with this template. After 

clicking the  icon placed next to it the user obtains a list of available templates. 
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Fig. 54.  Sample properties window 

 

In the Project library window you can also check what types of a particular element are currently in use in the 

projection, which is displayed in the form of the  symbol on the left of the name of a particular type. 
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Fig. 55. Type library editor window after saving a type in the project library. 

Below the two libraries there are the Hide everything   icons – once you click this icon the type tree in a 

particular library is reduced to the root folders. 

Extend everything  After clicking this icon, a type tree in a given library will be extended. 

The user may also search the type library by typing part or the entire name of the desired type in the 

 field. The search field will be cleared after clicking the  button. 

Once you select types or folders, the transfer buttons located between the libraries are activated. 

Copy all to the project library  – copies the entire global library content to the project library. 

Copy to the project library  – copies the selected elements to the project library. 

Copy to the global library  – copies the selected elements to the global library. 

Copy all to the global library  – copies the entire project library content of the selected element to the global 

library. 

 

Messages that may be displayed when working with the Type library editor: 

1. This message informs that there is already a type with this name. After clicking the  

information from the new type will be saved and will overwrite the information in the previous type.  

 



ArCADia-ELECTRICAL INSTALLATIONS         User Manual 
Working with the software 

 

58 

 
 

2. This message informs that the types marked by the user were removed. The  button 

confirms type deletion. 

 

 
 

3. This message informs that the layout of the project library was saved to a project template, e.g. Standard. 

 
 

 

NOTE! If the user has made any changes in the Project library while working with the project, modified existing 
types or expanded the library by adding new types, the new types will become available for future projects. The 
user should add the new types to the Global library using the transfer buttons. 

3.4.15 Generating a schematic diagram 

 ArCADia-ELECTRICAL INSTALLATIONS enables generating a schematic diagram of the indoor power 

supply lines for the particular switchgears. The diagram shows the power supply system of the designed 

installation, starting from the main distribution board up to all the department distribution boards. The diagram is 

generated in the form of a tree. All the items generated in the diagram can be edited and their properties can be 

defined. 

Once the  icon is clicked, a view handle (system of coordinates) appears on the bar, where you can enter a 

location on the projection of the generated diagram. Once the diagram is generated, when you click an item (e.g. 

distribution board), the following window appears: 
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Fig. 56. Properties window for an item on the generated diagram 

 

This window will define the colour, item description and its technical properties by clicking the "properties" 

button. 

3.4.16 Generation of lists 

 ArCADia-ELECTRICAL INSTALLATIONS enables generating lists of items used in the design. The software 

saves the list in the RTF format, which can be opened in any version of MS Word and OpenOffice.  

Once the  icon is clicked, a "Save to RTF file" dialogue box appears from the bar. This box is used to select the 

location where the generated lists will be saved on the hard drive. In order to preview the saved file you need to 

locate the path and open the file by double-clicking it. 

 

 

Fig. 57. Save list to RTF file window 

 

3.4.17 Generating calculation reports 

ArCADia-ELECTRICAL INSTALLATIONS enables generating calculation reports concerning the circuits 

designed by the user. The software saves the reports in the RTF format, which can be opened in any version of 

MS Word and OpenOffice. 

This function is selected by clicking the  icon on the tool bar. First, the software verifies the designed circuits. 

If any irregularities are disclosed, they will be displayed in the "Installation verification report" window. If at least 

one correct circuit can be found in the designed installation, we can obtain a report by clicking the "RTF report" 

button. 
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Fig. 58. Network inspection report window 

 

The "Save to RTF file" dialogue box appears for correctly designed networks or when the report is to be generated 

only for correct circuits. This window is sued to select the save destination path on the HDD for the generated 

report. In order to preview the saved file you need to locate the path and open the file by double-clicking it. 

 

 

Fig. 59. Save report/list dialogue box 

The generated report contains a specification of all the circuits output from the distribution panel. A table shows 

the values of load currents, short-circuit currents, power factor, installed power, load power for the particular 

circuits, tripping currents for the selected protections, voltage drops and lengths of the designed network sections. 


